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Chapter 1
Getting started

CompUter reqUIrEMENS
Installation packages and supporting files ... ..

Installation Packages ... ...... ...
Language files .

This guide explains how to customize and deploy the following software:

SMART Notebook™ collaborative learning software 11.2
SMART Notebook Math Tools software

3D Tools for SMART Notebook software

SMART Product Drivers 11.1

SMART Ink™ 1.1 SP1

SMART Response™ 2013 assessment software

SMART Common Files

NOTE

For information on customizing and deploying previous versions of this software, see the
appropriate system administrator's guides at smarttech.com/support.

This guide is intended for IT administrators and others experienced with customizing, deploying and
administering Windows® software in a networked environment. To use this guide, you must

Know IT terminology such as “registry” and “domain controller”

Know how to complete basic administrative tasks in Windows operating systems such as
modifying the registry

Have administrative privileges and access to servers

Have access to the Internet
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IMPORTANT

You must run the commands documented in this guide in an Administrator Command Prompt
window. To open an Administrator Command Prompt window, right-click the Command Prompt

icon, and then select Run as Administrator.

NOTE

Operating systems and other third-party software released after this SMART software might not be
supported.

Before you install the software, ensure your teachers’ computers meet the minimum requirements:

2

e Pentium® 4 processor or better
e 2GB of RAM

e Free hard disk space:

Software Space required
SMART Notebook software 832 MB
Gallery Essentials 575 MB
Lesson Activity Toolkit 136 MB
SMART Product Drivers 595 MB
SMART Ink 92 MB
SMART Response software 521 MB
SMART Common Files 295 MB
Recommended total free hard disk space 3GB

e Windows XP SP3, Windows 7 SP1 or Windows 8 operating system

¢ Microsoft® .NET Framework 4 Client Profile for SMART Notebook software and SMART Ink

o Microsoft Visual Studio® 2010 Tools for Office for SMART Ink
o Adobe® Flash® Player 11.7 ActiveX® control for SMART Notebook software

e Adobe Flash Player 11.7 Firefox® plug-in for SMART Notebook software and
SMART Response software
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Adobe Reader® 8.0 or later

DirectX® technology 9 or later for SMART Notebook software and SMART Video Player

o DirectX 9 compatible graphics hardware for 3D Tools for SMART Notebook software

¢ Internet Explorer® Internet browser 8 or later

NOTE

If you're deploying SMART software to Windows XP computers, you must first install Windows
Installer 4.5 on these computers. You can download Windows Installer 4.5 from
support.microsoft.com/kb/942288.

Before you can customize or deploy SMART software, you must locate the installation packages and
supporting files.

Installation packages
Before deploying the Education Software Installer installation package, you must deploy the following
third-party installation packages:

If you want to install this software: Deploy these installation packages:

SMART Notebook software o Microsoft .NET Framework 4 Client Profile files
(dotNetFx40_Client_x86_x64.exe)
« Adobe Flash Player ActiveX control
(install_flash_player_11_active_x.msi)
« Adobe Flash Player plug-in
(install_flash_player_11_plugin.msi)

SMART Product Drivers e Microsoft NET Framework 4 Client Profile files
(including SMART Ink) (dotNetFx40_Client_x86_x64.exe)

« Microsoft Visual Studio Tools for Office
(vstord0_x86.exe for 32-bit computers or
vstor40_x64.exe for 64-bit computers running
32-bit or 64-bit versions of Microsoft Office)

SMART Response software « Adobe Flash Player plug-in
(install_flash_player_11_plugin.msi)
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NOTE

You can run the dotNetFx40_Client_x86_x64.exe file to install all required Microsoft .NET
Framework prerequisites and the Microsoft .NET Framework 4 Client Profile files. However,
SMART recommends that you download the latest version of the Microsoft .NET Framework files
from the Microsoft website. For information on deploying the Microsoft .NET Framework, refer to
the .NET Framework deployment guide for administrators on the MSDN website
(msdn.microsoft.com/en-us/library/ee390831.aspx).

You can download the installation packages in a .zip file from
smarttech.com/administratordownloads. The installation packages are located in the Support folder
of the .zipfile.

IMPORTANT

SMART recommends that you deploy SMART software using the
SMARTEducationSoftware.msi installation package. However, if you choose to deploy the
software using individual installation packages, you need to do the following:

e Deploy the SMART Common Files.msi file first.

o If you use a custom value for the INSTALLDIR property, ensure this value is identical across
all the installation packages.

Save the installation packages in a location on your network that’s accessible to all computers on
which you plan to install the software.

Language files

If you plan to deploy the installation packages in a language other than English (U.S.), ensure the
corresponding MST file for the language is in the same folder as the MSI file (see Installation
language files and codes on page 57).

Similarly, if you want users to be able to view and use the software in a language other than English,
you must download and install the appropriate language pack (see Language packs on page 58).

These language packs are located in the downloaded .zip file under Support\Languages.
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Chapter 2

Customizing installation
packages

Using SMART Install Manager . . ... 5
Installing SMART Install Manager ... ... . 5
Using SMART Install Manager ........ ... 6

Opening an installation package ... ... . ... 6

Saving youUr Changes ... il 7
Publishing your changes as an MST file ... ... 7
Customizing the installation package ... .. ... 7
Using third-party t001S ... .. e 15

You can customize installation packages using SMART Install Manager.
OR

You can customize installation packages using third-party tools and Windows Installer properties.

SMART Install Manager enables you to customize SMART software installation packages (also
known as MSI files) by publishing MST files. You can then deploy the MSI and MST files to
computers using third-party imaging or remote management software.

Installing SMART Install Manager
Download and install SMART Install Manager from the SMART Support website.

To install SMART Install Manager from the website
1. Go to smarttech.com/administratordownloads.

2. Scroll to SMART Notebook collaborative leaming software, click Choose a version, and then
select SMART Notebook software > 11.2 for Windows.

3. Click Download SMART Install Manager, and then click Download.
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4. Save the Install Manager.exe file to your computer.
5. Double-click the Install Manager.exe file.
The SMART Install Manager installation wizard appears.

6. Follow the on-screen instructions.

Using SMART Install Manager
After you install SMART Install Manager, shortcuts to the software appear on the desktop and in the
Start menu (Windows XP and Windows 7 operating systems) or the Apps screen (Windows 8
operating system).
With SMART Install Manager, you can do the following:

e Open and customize an installation package.

e Save your changes to the installation package as an XML file.

e Publish your changes to the installation packages as an MST file.

Opening an installation package
To customize an installation package, drag its MSI file into the SMART Install Manager window.

Alternatively, you can search for installation packages on your computer by clicking o}

NOTE

All installation packages you’ve previously opened in SMART Install Manager appear in the
Unmodified Packages tab.
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After you open an installation package, a set of pages for that installation package appears in
SMART Install Manager. Customize the installation package using the controls on these pages.

Kl SMART Install Manager: Education Software Installer - Untitled =2 | B |
File Help
Py
=
SMART Install Manager SMART.
Welcome *  Product Selection e
Page ”nks e e Activate software during installation
DB ERE Select the products you want to instalk: Page content
Caution: You haven't selected any products. Select at least one product to install.
Language Selection
SMART Product Update [T SMART Product Drivers

]

Customer Experience
[] SMART Notebook software
SMART Notebeok

m

Product key:
Gallery Content

nom

Team Content
My Content
v [] SMART Response software
Optional Settings If you're instaling SMART Respanse CE (for use with SMART Notebook SE software) or SMART
Response VE software and you have a product key, enter the product key below.
SMART Respanse
Product key:
Activation Options

nom

Setup Tool

Optional Settings
[] SMART Motebock Math Tools

SMART Response VE Server i An activated version of SMART Notebook software is required. i

Saving your changes

After you customize an installation package, save your changes as an XML file by selecting File >
Save As. When you next start SMART Install Manager, load the XML file by selecting File > Open,
or by opening the MSI file and then selecting File > Import.

Publishing your changes as an MST file

The final step in using SMART Install Manager to customize an installation package is to publish your
changes as an MST file. To do this, select File > Publish, and then use the dialog box to define a
location for and create the MST file.

EJ TP

If you use an older MST file created with an earlier version of the MSI file, it might not work properly.
Use the current MSI file to create your MST file. Publish the MST file in the same location as the
MSI file.

Customizing the installation package

To customize the installation package, open the SMARTEducationSoftware.msi file in

SMART Install Manager (see Opening an installation package on the previous page), and then set the
controls on each page.
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Control

Procedure

Notes

General Options: Product Selection

Activate software during Select to activate the software You must include the
installation automatically during installation product key properties for the
rather than manually after software you're installing for
installation. this property to work.
For mass activation
information, see Activating the
software after installation on
page 21.
SMART Product Drivers Select to install Installing

SMART Product Drivers.

SMART Product Drivers also
installs SMART Ink.

SMART Notebook software

Select to install SMART Notebook
software.

Product key

Type your 22- or 25-character
product key for SMART Notebook
software.

As of version 11.1, you don’t
need to activate

SMART Notebook software.
SMART provides you with the
right to use this software when
you purchase a SMART
interactive product.

If you want to use

SMART Notebook software
with a device thatisn’'t a
SMART interactive product,
you must purchase a product
key.

You can type the product key
with or without hyphens.

When you type a volume
product key, the software
activates when you deploy it to
your network computers.

SMART Response
software

Select to install SMART Response

software.

If you choose to install
SMART Response software,
you must also install
SMART Notebook software.
When you select this check
box, SMART Install Manager
automatically selects
SMART Notebook.
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Control Procedure Notes
Product key If you're installing You can type the product key

SMART Response software and with or without hyphens.

students use When you type a volume

SMART Notebook SE (Student product key, the software

Edition) software or activates when you deploy it to

SMART Response VE Internet- your network Computers_

enabled devices to answer

questions, type your 22- or 25-

character product key for

SMART Response software.

SMART Notebook Math Select to install SMART Notebook | If you choose to install
Tools Math Tools software. SMART Notebook Math Tools
software, you must also install
SMART Notebook software.
Product key Type your 22- or 25-character You can type the product key
product key for SMART Notebook | with or without hyphens.

Math Tools software. When you type a volume
product key, the software
activates when you deploy it to
your network computers.

SMART Notebook 3D Select to install 3D Tools for If you choose to install 3D Tools
Tools SMART Notebook software. for SMART Notebook software,
you must also install
SMART Notebook software.
Product key Type your 22- or 25-character You can type the product key

product key for 3D Tools for
SMART Notebook software.

with or without hyphens.

When you type a volume
product key, the software
activates when you deploy it to
your network computers.

9 smarttech.com/kb/170504




CHAPTER 2

Customizing installation packages

Control

Procedure

Notes

General Options: Installation Options

Installation directory

Type the path to your preferred
folder for the software.

If you specify a folder, include a
back slash (\) at the end of the
path.

If you don’t specify a folder,
Windows Installer installs the
software in [Program files]
\SMART Technologies\
Education Software where
[Program files] is C:\Program
Files for 32-bit versions of
Windows operating systems or
C:\Program Files (x86) for 64-
bit versions of Windows
operating systems.

Ensure the folder path is valid.
SMART Install Manager doesn’t
verify the folder path.

Install Start menu and
desktop shortcuts

Select to create shortcuts in the
Start menu and on the desktop.

General Options: Language Selection

Select the language packs
you want to install

Select the language packs you
want to install.

Don’t select more than 20
language packs (see
smarttech.com/kb/170081).
Some SMART software doesn’t
support all listed languages.

General Options: SMART Product Update

Install SMART Product
Update in Full mode

Select to install
SMART Product Update (SPU) in
Full mode.

In Full mode, users can view
the installed versions of
SMART software as well as
their product keys, and
download and install updates.

Install SMART Product
Update in Dashboard mode

Select to install SPU in Dashboard
mode.

In Dashboard mode, users can
view only the installed versions
of SMART software and their
product keys.

Do not install SMART
Product Update

Select to not install SPU.
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Control Procedure Notes
Check for updates Type the number of days (1to60) | This option is available only if
between SPU checks. you install SPU in Full mode.
By default, SPU checks for
product updates every 30 days.
Notify users about SMART | Select to notify users of available | This option is available only if

product updates

SMART product updates through
the Windows notification area.

you install SPU in Full mode.

General Options: Customer Experience

Enable the Customer
Experience Program on all
devices

Select to automatically enable the
Customer Experience Program for
all users.

Disable the Customer
Experience Program on all
devices

Select to automatically disable the
Customer Experience Program for
all users.

SMART Notebook: Gallery Content

See Installing and maintaining Gallery content on page 61.

SMART Notebook: Team Content

Team Content path

Type the path to the

Team Content folder, which is a
location on your school’s network
where users can store shared
content.

For information on creating a
Team Content folder, see
Creating or connecting to Team
Content folders on page 72.

SMART Notebook: My Content

My Content path

Type the path to the My Content
folder, which is alocation on the
user's computer where he or she
can store individual content.

You can include environment
variables in the path.

SMART Notebook: Optional Settings

Install print capture driver

Select to include the Print Capture
Driver in the installation.

The Print Capture Driveris a
printer driver that enables users
to export content from other
programs to SMART Notebook
software by using the

SMART Notebook Document
Writer.
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Control Procedure Notes

Register Select to enable the registration of | Disable the registration of
SMART Document Camera | SMART Document Camera™ SMART Document Camera
drivers drivers. drivers if they conflict with the

third-party drivers on the
compulter.

If you choose to install 3D Tools
for SMART Notebook software,
SMART Install Manager selects
this check box automatically.
You're unable to clear it.

Enable hardware
acceleration

Select to enable hardware
acceleration.

Through hardware acceleration,
SMART Notebook software
completes some tasks using
your computer’s graphics
processing unit (GPU) rather
than its central processing unit
(CPU). Hardware acceleration
improves the performance of
SMART Notebook software on
most computers. However,
hardware acceleration can
cause issues on some
computers, such as content not
displaying correctly and
SMART Notebook software not
responding. If users are
encountering these issues, you
can disable hardware
acceleration.

Copy the
SMART Notebook tutorial
file

Select to copy the

SMART Notebook software tutorial
file to the user's Documents folder.

The SMART Notebook
software tutorial file opens
when a user first starts the
software. It demonstrates how
to use the software and what’s
new in the current version of the
software.

If there is limited space on
users’ computers, you can
choose to not copy the tutorial
file to their Documents folders.
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Control

Procedure

Notes

SMART Response: Setup T

ool

SMART Response LE

Select to enable students to
answer questions with
SMART Response LE clickers.

SMART Response PE

Select to enable students to
answer questions with
SMART Response PE clickers.

SMART Response XE

Select to enable students to
answer questions with
SMART Response XE clickers.

SMART Response/Senteo

Select to enable students to
answer questions with

SMART Response or Senteo™
clickers.

SMART Response VE

Select to enable students to
answer questions with

SMART Response VE Internet-
enabled devices.

SMART Notebook SE

Select to enable students to
answer questions with

SMART Notebook SE software in
SMART Response CE mode.

3 Which country sponsored Columbus's voyage?
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Control

Procedure

Notes

Multiple SMART Response
devices in the same class

Select to enable students to
answer questions with Senteo,
SMART Response,

SMART Response LE,

SMART Response PE or
SMART Response XE clickers, or
SMART Notebook SE software.
Select Include

SMART Response VE to also
enable students to answer
questions with SMART Response
VE Internet-enabled devices.

SMART Response: Option

al Settings

Start Desktop Menu at log
in for all users

Select to start SMART Response
software when the user logs on.

Install the education
standards database

Select to install the
SMART Response education
standards database.

File port

Type the port number for the file
data channel.
OR

Type * to use a random port
number for the file data channel.

This control is applicable only if
students answer questions with
SMART Notebook SE
software.

The default port is 23458.

Secure Base port

Type the port number for the
encrypted data channel.

OR

Type * to use a random port
number for the encrypted data
channel.

This control is applicable only if
students answer questions with
SMART Notebook SE
software.

The default port is 23457.

Certificate file

Type the path to the certificate file
for SSL digital certificate
encryption.

OR

Click Browse and then browse to
and select the certificate file.

This control is applicable only if
students answer questions with
SMART Notebook SE
software.

SMART Response: SMART Response VE Server

Local server website

Type the URL of the

SMART Response VE Server (for
example,
http://response.example.com).

14 smarttech.com/kb/170504




CHAPTER 2

Customizing installation packages

Control Procedure Notes

SMART Product Drivers: Optional Settings

Enable Tablet PC Support | Select to use Tablet PC This property is applicable for
functionality with your SMART the Windows 7 operating
interactive display without having | systems. It has no effect on
to connect a Tablet PC. other operating systems.

Start SMART Board Tools | Select to start SMART Board
at logon Tools when the user logs on.

Start SMART Ink at logon | Select to start SMART Ink when
the user logs on.

Make SMART Ink Viewer Select to make SMART Ink Viewer

the default PDF viewer to the default PDF viewer.

Start SMART Vantage Select to enable Enable these services if your

services at logon SMART Vantage™ and SNMP school or district is using
Agent services. SMART Vantage software.

You can customize SMART software installation packages by creating MST files using a third-party
tool, such as Orca database editor, and the Windows Installer properties (see Windows Installer
properties and parameters on page 43).
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Using the command line interface ... . 18
Installing prerequisite third-party software ... ... 18
Installing SMART software .. ... ... 19

Using third-party imaging or remote management software ... ... ... ... ... 20

Activating the software afterinstallation ... .. 21

RENEWING KBY S e 25
Renewing keys inunattended mode ... ... 26
Renewing keys inuserinterface mode .. ...l 27
Enabling and disabling automatic renewal of Keys ... ... . i .. 28

You can deploy installation packages using the command line interface.
OR

You can deploy installation packages using third-party imaging or remote management software.

IMPORTANT
¢ Close any Firefox browser windows before installing the Adobe Flash Player plug-in.

o Regardless of how you deploy the software, you must choose to install at least one of the
software products. Otherwise, the SMARTEducationSoftware.msi file does not install any of
the software products.

o If you are deploying SMART Product Drivers, the user must restart (Windows XP operating
systems) or log off and log back on (Windows 7 and Windows 8 operating systems) after you
deploy the software to start the SMART Board Service. In addition, an error message might
appear after you deploy the software stating that the SMARTBoardService.exe file could not
be found. The user can close this error message.

o If you want to install language packs, you must do so when you first deploy the software. If
you want to install a language pack after you first deploy the software, you must do so using
the language pack’s individual MSI file.
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NOTE

You might need to manually activate the software after you deploy it.

Using the command line interface, you can deploy installation packages in many ways, including
running commands from the Command Prompt window and including commands in batch script files.

Installing prerequisite third-party software

To install the Microsoft .NET Framework 4 Client Profile files
NOTE

SMART recommends that you follow the instructions on deploying the Microsoft .NET
Framework in the .NET Framework deployment guide for administrators on the MSDN
website (msdn.microsoft.com/en-us/library/ee390831.aspx).

Run the following command to install the files in Ul mode:

[Path]\dotNetFx40 Client x86 x64.exe /passive /showfinalerror
OR

Run the following command to install the files in silent mode:

[Path]\dotNetFx40 Client x86 x64.exe /q

Where [Path] is the path to the dotNetFx40_Client_x86_x64.exe file.

To install Microsoft Visual Studio Tools for Office for 32-bit computers
Run the following command:

[Path]\vstor40 x86.exe /g

Where [Path] is the path to the vstor40_x86.exe file.
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To install Microsoft Visual Studio Tools for Office for 64-bit computers

Run the following command:
[Path]\vstor40 x64.exe /g

Where [Path] is the path to the vstor40_x64.exe file.

To install the Adobe Flash Player ActiveX control

Run the following command:

msiexec /i "[Path]\install flash player 11 active x.msi"

[Parameter]

Where
o [Path]is the path to the install_flash_player_11_active_x.msi file.

o [Parameter] is the installation parameter (see Parameters on page 54).

To install the Adobe Flash Player plug-in

Run the following command:

msiexec /i "[Path]\install flash player 11 plugin.msi" [Parameter]

Where
o [Path]is the path to the install_flash_player_11_plugin.msi file.

o [Parameter] is the installation parameter (see Parameters on page 54).

Installing SMART software
To install SMART software
Run the following command if you created an MST file to customize the installation package:

msiexec /i " [Path]\SMARTEducationSoftware.msi" TRANSFORMS="
[MST file]" [Parameter]

OR
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Run the following command if you didn’t create an MST file to customize the installation
package:

msiexec /1 " [Path]\SMARTEducationSoftware.msi" [Properties]

[Parameter]

Where
o [Path]is the path to the SMARTEducationSoftware.msi file and MST file.
o [MST file] is the name of the MST file.

o [Properties] is a set of properties you can include to customize the installation (see
Properties on page 43).

o [Parameter] is the installation parameter (see Parameters on page 54).

The following procedure shows how to deploy SMART software using Group Policy-based
deployment software. For information on deploying SMART software using your organization’s
third-party imaging or remote management software, see the software’s documentation.

NOTES

o This procedure may vary depending on your version of Windows operating system and your

system preferences.

o Ensure your domain controller has Windows Installer 4.5.

To deploy an installation package

1. Copy the MSI file and the MST file to \[Domain ControllerNNETLOGON, where
[Domain Controller] is your domain controller.

2. Open Control Panel, double-click Administrative Tools, and then double-click Active
Directory Users and Computers.

The Active Directory Users and Computers window appears.
3. Right-click your domain, and then select Properties.

The Properties dialog box appears.
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4. Click the Group Policy tab, and then click Edit.
The Group Policy Object Editor dialog box appears.
5. Browse to Computer Configuration\Software Settings.

6. Right-click Software Installation, select New > Package, and then browse to and select the
MSiI file from step 1.

7. Inthe Deploy Software section, click Advanced, and then click OK.
8. Click the Modifications tab, click Add, and then browse to and select the MST file from step 1.
9. Click OK to apply the MST file to the MSI file.

10. Close all open windows and dialog boxes.

The next time each computer on the domain starts, the computer automatically installs the
software in Silent mode with the customizations defined in the MST file.

There are two situations in which the software doesn’t activate completely:

o Imaging a computer: Activation is linked to the hardware identifier of the computer the
software is installed and activated on. If you clone a hard drive image with installed and
activated software, you must activate the software on each cloned computer.

¢ Reverting a computer to an earlier state: If you use system recovery or protection software
that periodically restores the computer to an earlier state, you might need to activate the
software before locking the computer so that the activation record is not cleared each time the
computer is restored.

Run the activation wizard while connected to the network or complete the following procedure to
activate the software on each computer.

NOTE

You don’t need to activate SMART Notebook software or SMART Product Drivers. SMART
provides this software to you when you purchase a SMART interactive product.

To activate SMART software after installation

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe"
--puid education bundle --m=[Value] --v=3 --a [Optional flags]
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[Product keys]

Where
o [Value]is 4 to run the activation wizard in unattended mode.
OR
[Value] is 6 to run the activation wizard in user interface mode.

o [Optional flags] are optional flags you can include to configure the activation wizard.

Flag Purpose

--monitor=[Number] Specify the monitor to display the activation wizard.

--proxy=[Host:Port] Specify the proxy host and port number to use for
activation.

--proxyuser=[User] Specify the proxy user name to use for activation.

--proxypassword=[Password] Specify the proxy password to use for activation.

--locale=[Code] Display the activation wizard user interface in a
specific language, where [Code] is your language
code (see Installation language files and codes on
page 57).

o [Product keys] are one or more software product keys you want to activate. Each product
key must be in the following form:

--pk [Product key]

Where [Product key] is the software product key.

To activate only SMART Notebook Math Tools software after installation

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe"
--puid education bundle --m=[Value] --v=3 --a [Optional flags]
--pk [Product key]
Where
o [Value]is 4 to run the activation wizard in unattended mode.

OR

[Value] is 6 to run the activation wizard in user interface mode.

22 smarttech.com/kb/170504



CHAPTER 3

Deploying the software

o [Optional flags] are optional flags you can include to configure the activation wizard.

Flag Purpose

--monitor=[Number] Specify the monitor to display the activation wizard.

--proxy=[Host:Port] Specify the proxy host and port number to use for
activation.

--proxyuser=[User] Specify the proxy user name to use for activation.

--proxypassword=[Password] Specify the proxy password to use for activation.

--locale=[Code] Display the activation wizard user interface in a
specific language, where [Code] is your language
code (see Installation language files and codes on
page 57).

o [Product key] is the software product key.

To activate only 3D Tools for SMART Notebook software after installation

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe"
--puid education bundle --m=[Value] --v=3 --a [Optional flags]
--pk [Product key]

Where
o [Value]is 4 to run the activation wizard in unattended mode.
OR

[Value] is 6 to run the activation wizard in user interface mode.
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o [Optional flags] are optional flags you can include to configure the activation wizard.

Flag Purpose

--monitor=[Number] Specify the monitor to display the activation wizard.

--proxy=[Host:Port] Specify the proxy host and port number to use for
activation.

--proxyuser=[User] Specify the proxy user name to use for activation.

--proxypassword=[Password] Specify the proxy password to use for activation.

--locale=[Code] Display the activation wizard user interface in a
specific language, where [Code] is your language
code (see Installation language files and codes on
page 57).

o [Product key] is the software product key.

To activate only SMART Response software after installation

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe" --puid response 3a
--uipack response 3 --m=[Value] --v=3 --a [Optional flags]
--pk [Product key]

Where
o [Value]is 4 to run the activation wizard in unattended mode.
OR

[Value] is 6 to run the activation wizard in user interface mode.
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o [Optional flags] are optional flags you can include to configure the activation wizard.

Flag Purpose

--monitor=[Number] Specify the monitor to display the activation wizard.

--proxy=[Host:Port] Specify the proxy host and port number to use for
activation.

--proxyuser=[User] Specify the proxy user name to use for activation.

--proxypassword=[Password] Specify the proxy password to use for activation.

--locale=[Code] Display the activation wizard user interface in a
specific language, where [Code] is your language
code (see Installation language files and codes on
page 57).

o [Product key] is the software product key.

NOTE

This command is applicable only if you're running SMART Response software in CE mode
(students answer questions with SMART Notebook SE software) or VE mode (students
answer questions with Internet-enabled devices). Instructions for activating all other modes
are included in the SMART Response documentation.

If your school has purchased maintenance or subscription licenses, SMART software attempts to
renew the keys automatically on a scheduled basis before and after the keys’ expiry dates. However,
you can choose to explicitly renew the keys at a specified time. You can also choose to disable
automatic renewal in situations where you don’t want the keys on a computer to be renewed
(because, for example, you’re planning to retire the computer).

EJ TP

The activation wizard user interface distinguishes between maintenance and subscription licenses:
o Maintenance licenses are labeled with “Valid for versions released before [Date]’.

o Subscription licenses are labeled with the expiration date of the key.
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Renewing keys in unattended mode

To renew all keys

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe" --m=15 --v=3

--renewal-mode all

To renew all keys associated with a single product

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe" --m=15 --v=3

--renewal-mode product --puid=/[Product]
Where [Product] is response_3a or education_bundle.

NOTE

This command renews all keys associated with the specified product.

To renew specific keys

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe" --m=15 --v=3

--renewal-mode product --puid=[Product] [Product keys]

Where
o [Product]is response_3a or education_bundle.

o [Product keys] are one or more software product keys you want to renew. Each product
key must be in the following form:

--pk=[Product key]

Where [Product key] is the software product key.
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Renewing keys in user interface mode

To renew all keys associated with a single product

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe" --m=16 --v=3
--renewal-mode product --puid=[Product] --uipack=[UI pack]

Where
o [Product]is response_3a or education_bundle.

o [Ul pack] is the corresponding Ul pack for the selected product (response_3 or
education_bundle).

NOTE

This command renews all keys associated with the specified product.

To renew specific keys

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe" --m=16 --v=3
--renewal-mode product --puid=[Product] --uipack=[UI pack]
[Product keys]

Where
o [Product]is response_3a or education_bundle.

o [Ul pack] is the corresponding Ul pack for the selected product (response_3 or
education_bundle).

o [Product keys] are one or more software product keys you want to renew. Each product
key must be in the following form:

--pk=[Product key]

Where [Product key] is the software product key.
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Enabling and disabling automatic renewal of keys

To enable automatic renewal of specific keys

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\

SMART Product Updatelactivationwizard.exe" --m=17
--puid=[Product] --v=3 --auto-renew [Product keys]
Where

o [Product]is response_3a or education_bundle.

o [Product keys] are one or more software product keys you want to renew automatically.
Each product key must be in the following form:

-—-pk=[Product key]

Where [Product key] is the software product key.

To disable automatic renewal of specific keys

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\

SMART Product Updatelactivationwizard.exe" --m=17
--puid=[Product] --v=3 --no-auto-renew [Product keys]
Where

o [Product]is response_3a or education_bundle.

o [Product keys] are one or more software product keys you don’t want to renew
automatically. Each product key must be in the following form:

--pk=[Product key]

Where [Product key] is the software product key.

To disable automatic renewal on a computer

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe" --m=18 --v=3

-—-no—-auto-renew
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To enable automatic renewal on a computer

Run the following command:

"C:\Program Files\Common Files\SMART Technologies\
SMART Product Updatelactivationwizard.exe" --m=18 --v=3

—-—auto-renew
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SMART periodically releases updates to its software. These updates add new features and resolve
issues.

Go to smarttech.com/software to download the latest installation package. SMART provides updates
in two file formats in the installation package:

Go to smarttech.com/software to download the latest installation package. SMART provides updates
in MSI file format in the installation package:

o Windows Installer update installation packages (MSI files)

e Windows Installer patches (MSP files)

NOTE

MSP files are available only for select updates as identified on the SMART website.

Which file format you use depends on the version of the software installed on your computers and the
version of the update. If these versions are the same, you can use the MSP file, if available, to install
the update. If these versions are different (because, for example, a previous version of the software is
installed on your computers), you must first upgrade the software on your computers to the same
version as the update using the MSI file and then install the update using the MSP file, if available.

After you download an installation package and extract the update files, place the update files in a
location on your network that’s accessible to all the computers you plan to update.

IMPORTANT

You cannot roll back an update after installing it on your computers. You must remove the full
version of the software using Control Panel or the command line interface (see Removing the
software on page 35), and then install the previous version of the software.
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The command line for running an update using a Windows Installer update installation package varies
depending on whether the update is major or minor.

NOTE

The SMART website indicates whether an update is major or minor.

To run a major software update using a Windows Installer update installation package

Run the following command:

msiexec /i " [Path]\[File].msi" [Parameter]

Where
o [Path]is the path to the MSI file.
o [File] is the name of the MSI file.

o [Parameter] is the installation parameter (see Parameters on page 54).

IMPORTANT
Do not include the REINSTALLMODE and REINSTALL properties.

To run a minor software update using a Windows Installer update installation package

Run the following command:

msiexec /i " [Path]\[File].msi" REINSTALLMODE=vomus REINSTALL=ALL
[Parameter]
Where
o [Path]is the path to the MSI file.
o [File] is the name of the MSl file.

o [Parameter] is the installation parameter (see Parameters on page 54).
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IMPORTANT

You must include the REINSTALLMODE=vomus and REINSTALL=ALL properties for a
minor update to succeed.

To run a software update using a Windows Installer patch

Run one of the following commands:

msiexec /p "[Path]\[File].msp" REINSTALLMODE=omus /g

msiexec /update " [Path]\[File].msp" /quiet

Where
o [Path]is the path to the MSP file.
o [File] is the name of the MSP file.

33 smarttech.com/kb/170504






Chapter 5
Removing the software

Using the Userinterface ... 35
Using the command line interface ... .. 36
Recommended procedures ... il 36
Other COMMANAS .. L 39
Product COOES ..o . 40
SMART Notebook software ... .. . 40

SMART Response software ... ... 40

SMART Product Drivers ... .. 41

SMAR T INK L 41

SMART Common Files ..o L 42

SMART Uninstaller enables you to remove SMART software.

You can remove SMART software from individual computers using the SMART Uninstaller user
interface.

To remove SMART software

1. InWindows XP and Windows 7 operating systems, select Start > All Programs >
SMART Technologies > SMART Tools > SMART Uninstaller.

OR

In Windows 8 operating system, go to the Apps screen and then scroll to and
press SMART Uninstaller.

2. Press Next.
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3. Select the check boxes of the SMART software and supporting packages that you want to
remove, and then press Next.

NOTES

o Some SMART software is dependent on other SMART software. For example, if you
select the SMART Notebook check box, SMART Uninstaller selects the
SMART Response check box automatically because SMART Response software is
dependent on SMART Notebook software.

o SMART Uninstaller automatically removes any supporting packages that are no longer
being used. If you choose to remove all SMART software, SMART Uninstaller
automatically removes all supporting packages, including itself.

£] Tips

o To select all software and supporting packages, press Select All.

o To clear the selection of all software and supporting packages, press Clear All.

4. Press Uninstall.
SMART Uninstaller removes the selected software and supporting packages.

5. Press Finish.

In addition to removing SMART software using the SMART Uninstaller user interface, you can
remove SMART software using the SMART Uninstaller command line interface. This enables you to
automate the removal of SMART software and remove SMART software remotely.

Recommended procedures
The following are recommended procedures for removing SMART software using the SMART
Uninstaller command line interface.

NOTE

SMART recommends that you copy SMART Uninstaller to a temporary location before running
command lines and prefix command lines with start /wait.
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To remove all SMART software
1. Copy SMART Uninstaller to a temporary location by running one of the following commands:

o For 32-bit operating systems:

copy "%CommonProgramFiles$\SMART Technologies\
SMART Uninstaller.exe" "STEMPS"

o For 64-bit operating systems:

copy "%CommonProgramFiles (x86)%\SMART Technologies\
SMART Uninstaller.exe" "S$STEMPS"

2. Remove all software by running the following command:

start /wait "SMART Uninstaller" "$TEMP$\SMART Uninstaller.exe"

--noui --uninstall-all --uilevel none

3. Delete the copy of SMART Uninstaller in the temporary location by running the following
command:

del "$TEMP%"\SMART Uninstaller.exe"

To remove select SMART software by product name
1. Copy SMART Uninstaller to a temporary location by running one of the following commands:

o For 32-bit operating systems:

copy "%CommonProgramFiles$\SMART Technologies\
SMART Uninstaller.exe" "S$STEMPS"

o For 64-bit operating systems:

copy "%CommonProgramFiles (x86) %$\SMART Technologies\
SMART Uninstaller.exe" "STEMPS"
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2. Remove select software by running the following command:

start /wait "SMART Uninstaller" "$TEMP%\SMART Uninstaller.exe"

--noui —--uninstall " [Product names]" --uilevel none

Where [Product names] is a comma delimited list of product names (for example,
SMART Notebook,SMART Response).

4. Delete the copy of SMART Uninstaller in the temporary location by running the following
command:

del "$TEMP%"\SMART Uninstaller.exe"

To remove select SMART software by product code
1. Copy SMART Uninstaller to a temporary location by running one of the following commands:

o For 32-bit operating systems:

copy "%CommonProgramFiles$\SMART Technologies\
SMART Uninstaller.exe" "STEMPS"

o For 64-bit operating systems:

copy "%CommonProgramFiles (x86) %$\SMART Technologies\
SMART Uninstaller.exe" "S$STEMPS"

2. Remove select software by running the following command:

start /wait "SMART Uninstaller" "$TEMP$%\SMART Uninstaller.exe"

--noui --uninstall-pc [Product codes] --uilevel none

Where [Product codes] is a comma delimited list of product codes (see Product codes on page
40).

4. Delete the copy of SMART Uninstaller in the temporary location by running the following
command:

del "$TEMP%"\SMART Uninstaller.exe"
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Other commands

In addition to the commands in the recommended procedures, you can include the following

commands with SMART Uninstaller.

Command

Description

Notes (if any)

--dry-run

Runs the command line but
doesn’t remove the
software.

This is useful for testing
command lines before
implementing them.

--locale [Language code]

Where [Language code] is a language
code (for example, fr for French)

Displays SMART
Uninstaller in alanguage
other than the operating
system’s language.

The appropriate language
pack must be installed to
display SMART Uninstaller
in the language.

-—-uilevel [Level]

Where [Level] is none, basic (default),
reduced or full

Specifies the user interface
that displays when SMART
Uninstaller removes the
software.

Normally, --uilevel none
is used only in combination
with --noui.

-—-no—auto-remove

Disables the automatic
removal of supporting
packages (for example,
SMART Common Files)
that are no longer required
after the selected
packages are removed.

This is used only if --noui
is also included.

--noui

Doesn’t display the
SMART Uninstaller user
interface.

Normally, --noui is used
only in combination with
--uilevel none.

--uninstall-all

Removes all detected
SMART packages.

--uninstall [Product names]
Where [Product names] is acomma
delimited list of product names (for
example,

SMART Notebook,SMART Response

)

Removes the specified
products.

--uninstall-pc
[Product codes]

Where [Product codes] is a comma

delimited list of product codes (see
Product codes on the next page)

Removes the specified
products.
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Product codes

SMART Notebook software

Version Product code

10.0.124.0 {3E926B45-3748-40F9-8A30-99B225E 1D 2E5}
10.0.126.0 {F581DF68-CAE9-4064-A6CD-705D95D 1C756}
10.0.132.0 {F581DF68-CAE9-4064-A6CD-705D95D 1C756}
10.0.187.1 {F581DF68-CAE9-4064-A6CD-705D95D 1C756}
10.1.253.1 {D836B93F-3030-4047-99D 3-65304A25839A}
10.0.517.2 {A51CDA36-B81D-4934-9C9D-B649A0DBF4CD}
10.0.596.3 {5C98A4FE-1F42-4F02-B738-F32886AE5467}
10.0.631.3 {5C98A4FE-1F42-4F02-B738-F32886AE5467}
10.6.94.0 {0A0719F0-AD56-42BA-B68C-EFFC330B6F 13}
10.6.140.1 {47TEBA509-37B7-4440-A252-7031E9A898D 7}
10.7 {9550F8A6-3D21-4544-8B87-FOFE7E01B964}
10.8 {EDOFF410-41B9-441F-B457-4AC81782E8BF}
11.0 {AFE024C7-7CA7-4C8E-90EE-D877C7CD96A3}
11.1 {A810B5F5-8ACA-4670-B6B3-F98B07DFF6C4}
11.2 {82E3F365-86BD-4EA8-80CA-F498EBE89537}

SMART Response software

Version Product code

2.0.97.0 {BDB1F637-C890-4B86-A5A7-D20D8DBE176B}
2.1.307.0 {CFD7DD74-42F9-4B50-AFCD-1EOBOF5ABBA4}
2.2.591.1 {7A63D2B1-DE99-4DB3-93E7-8FDEDD49E3E3}
2.5.39.0 {D04D1BAC-D63F-498F-B613-FB7BCF2F6C52}
3.0.159.0 {6FFCF813-06AF-468A-AD64-7F9B04DDOEDA}
3.0.256.1 {8B4CE9CA-ECB7-47D1-845E-E1167FFB3F 1B}
3.5 {3ABF6865-E84E-4DAB-B730-0EBOE8F37EB1}
4.0 {02885557-ACA5-4B6F-85D 2-3F 1A9B8580F 5}
4.5 {BBOA384B-10C 1-478A-8A3C-538B74590484}
4.6 {2D13D1AD-856F-4C63-BBF1-C2963197F4D0}
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SMART Product Drivers

Version Product code

10.0.124.0 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.131.0 {FF7AB84AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.163.1 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.165.1 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.186.2 {FF7AB84AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.188.3 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.232.4 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.255.5 {FF7AB84AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.314.5 {FF7A64AB-214A-47D1-95E7-742BCBA7F6C9}
10.0.392.6 {00C68967-9790-40DA-86F 7-FDB248A5CDB1}
10.0.528.7 {AA9C1126-50DD-4993-9CDC-0BED8167293C}
10.0.532.7 {984EAE92-6043-451A-B786-9327FF 165310}
10.6.48.0 {2623A1E3-478A-4F4A-A522-3A3D784A0C9C}
10.6.106.1 {487F1117-8BDE-4518-A798-015172AE0410}
10.6.175.2 {333B0B76-FC96-4C51-9AF6-B6EFA15ACE99}
10.7.81.0 {1355416A-967D-47C5-823D-D493C3E0B97C}
10.7 SP1 {4CE6C6E8-0DAD-4757-86ED-7FB4035BA98B}
10.8 {67E6410C-1E97-4D03-BEC2-8E83323A6BBD}
11.0 {E3189F44-F7BD-4F96-B756-A0AEFAF61D3A}
11.1 {E91FBB79-D736-4834-A1AB-2A5CDD2DB7E7}
SMART Ink

Version Product code

1.0 {4A1F2472-6164-43FA-9D2F-B35E71A8DF32}
1.1 {4A1F2472-6164-43FA-OD2F-B35E71A8DF32}
1.1 SP1 {FOE390A2-AB03-4077-83C4-F12D3A65493D}
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SMART Common Files

Version Product code

2011 (10.8) {OESDD7A3-BE29-430C-970B-C553F4A58C39}
2012 (11.0) {ED2455F7-6AA6-4D3C-85E9-A72297DD7051}
2013 (11.1) {3D7235B2-3305-4FE1-A9A1-5F8AC2F 33122}
2013 (11.2) {9057211D-439A-4C0D-95DE-498CF54ADF8C}
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Windows Installer properties and
parameters

Properties
Parameters
Examples

The following are properties for the installation package.

installation (see Installation language
files and codes on page 57).

Property Allowed values Notes
General properties
TRANSFORMS | [String]: A language MST file for the Ensure the specified MST file is in the

same folder as the MSl file.

This property defines the language of
the installer’s user interface and the
installed software’s icons and
shortcuts. It doesn’t define the
installed software’s user interface
language. The installed software uses
the computer's operating system
language if it's supported, or English
(U.S.)if not.

You can also use the TRANSFORMS
property to apply an MST file created
by SMART Install Manager (see Using
SMARYT Install Manager on page 5) or
a third-party tool.
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Property Allowed values Notes
ACTIVATE_ 1 (default): Register the product keys | You must include the product key
LICENSE and automatically activate the properties for the software you're
software. installing for this property to work.
[Empty string]: Register the product For mass activation information, see
keys but don’t automatically activate | Activating the software after
the software. installation on page 21.
INSTALL_ 1: Install SMART Product Drivers. Installing SMART Product Drivers
BOARD alsoinstalls SMART Ink.
INSTALL _ 1: Install SMART Notebook software.
NOTEBOOK
NB_PROD_KEY |[String]: The 22- or 25-character As of version 11.1, you don’t need to
product key for SMART Notebook activate SMART Notebook software.
software you received from SMART. | SMART provides you with the right to
use this software when you purchase
a SMART interactive product.
If you want to use SMART Notebook
software with a device that isn't a
SMART interactive product, you must
purchase a product key.
This property automatically appears in
the Product Key box in the activation
wizard if you choose not to include the
ACTIVATE_LICENSE property.
INSTALL _ 1: Install SMART Response software. | If youinclude the INSTALL_
RESPONSE RESPONSE property, Windows
Installer installs SMART Notebook
software even if you don’t include the
INSTALL_NOTEBOOK property.
RESP_PROD _ [String]: The 22- or 25-character This property automatically appears in
KEY product key for SMART Response the Product Key box in the activation
software you received from SMART if | wizard if you choose not to include the
students use SMART Notebook SE ACTIVATE_LICENSE property.
software or SMART Response VE
Internet-enabled devices to answer
questions.
ENABLE_ 1: Install SMART Notebook If you include the ENABLE_MATH_
MATH_TRIAL Math Tools software. TRIAL property, Windows Installer

installs SMART Notebook software
even if you don’t include the
INSTALL_NOTEBOOK property.
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[Empty string]: Don’t include
shortcuts to the software on the
desktop.

Property Allowed values Notes
MATH_PROD_  |[String]: The 22- or 25-character This property automatically appears in
KEY product key for SMART Notebook the Product Key box in the activation
Math Tools software you received wizard if you choose not to include the
from SMART. ACTIVATE_LICENSE property.
ENABLE_MR _ 1: Install 3D Tools for If you include the ENABLE_MR _
TRIAL SMART Notebook software. TRIAL property, Windows Installer
installs SMART Notebook software
even if you don'’t include the
INSTALL_NOTEBOOK property.
MIXED_PROD_ |[String]: The 22- or 25-character This property automatically appears in
KEY product key for 3D Tools for the Product Key box in the activation
SMART Notebook software you wizard if you choose not to include the
received from SMART. ACTIVATE_LICENSE property.
INSTALLDIR [String]: The path to your preferred If you specify a folder, include a back
folder for the software. slash (\) at the end of the path.
If you don't specify a folder, Windows
Installer installs the software in
[Program files\SMART
Technologies\
Education Software where [Program
files] is C:\Program Files for 32-bit
versions of Windows operating
systems or C:\Program Files (x86)
for 64-bit versions of Windows
operating systems.
DESKTOP_ 1 (default): Include shortcuts to the
ICONS software on the desktop.

SPU properties

INSTALL_SPU

1 (default): Install SPU in Full mode.
2: Install SPU in Dashboard mode.
0: Don't install SPU.

In Full mode, users can view the
installed versions of SMART software
as well as their product keys, and
download and install updates.

In Dashboard mode, users can view
only the installed versions of SMART
software and their product keys.
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0: Don't notify the user when updates
are available from SPU.

Property Allowed values Notes
SPU_TIME_ [Integer]: The time in days (1 to 60) By default, SPU checks for product
FRAME between SPU checks. updates every 30 days.
This property is applicable only if you
install SPU.
PRODUCT_ 1 (default): Notify the user when This property is applicable only if you
NOTIFICATION | updates are available from SPU. install SPU.

Customer Experience Program properties

CUSTOMER _
LOGGING

0: Disable the Customer Experience
Program.

1 (default): Enable the Customer
Experience Program.
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Property

Allowed values

Notes

SMART Notebook software properties

CONTENT_
TARGET
PATH
CONTENT_
SOURCE._
PATH

NETWORK_
CONTENT

If you're installing Gallery content on
each user's computer from the
SMART website (option 1):

e Set CONTENT _TARGET_
PATH to the path of the folder
where you want to install the
Gallery content (if you don’t want
to use the default folder).

If you're installing Gallery content on
each user's computer from a folder on
your school’s network (option 2):

e Set CONTENT_SOURCE_
PATH to the path of the folder on
your school’s network that
contains the Gallery Essentials
and Lesson Activity Toolkit
folders.

e Set CONTENT_TARGET_
PATH to the path of the folder
where you want to install the
Gallery content (if you don’t want
to use the default folder).

If you're installing Gallery content ina
central location (option 3):

e Set NETWORK_CONTENT
to 1.

e Set CONTENT_TARGET_
PATH to the path of the the folder
on your school’s network that
contains the Gallery Essentials
and Lesson Activity Toolkit
folders.

For more information on the three
options, see Installing Gallery content
on page 62.

If you select option 3, Windows
Installer ignores the FULL_GALLERY
and *_CONTENT properties.

The default Gallery folder on Windows
7 and Windows 8 computers is [All
users profile folderN\SMART
Technologies.

The default Gallery folder on Windows
XP computers is [All users profile
folder\Application Data\SMART
Technologies.

FULL_GALLERY

1: Install the full Gallery Essentials
collection.

ADMIN_ 1: Install the Administration and Don’t include this property if you

CONTENT Evaluation category. included the FULL_GALLERY
category.

ARTS 1: Install the Arts category. Don't include this property if you

CONTENT included the FULL_GALLERY

category.
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Property Allowed values Notes

ENGLISH_ 1: Install the English and Language Don't include this property if you

CONTENT Arts category. included the FULL_GALLERY
category.

GEOGRAPHY_ | 1: Install the Geography category. Don't include this property if you

CONTENT included the FULL_GALLERY
category.

HISTORY_ 1: Install the History category. Don't include this property if you

CONTENT included the FULL_GALLERY
category.

MATH_ 1: Install the Mathematics category. Don't include this property if you

CONTENT included the FULL_GALLERY
category.

PEOPLE_ 1: Install the People and Culture Don't include this property if you

CONTENT category. included the FULL_GALLERY
category.

SCIENCE_ 1: Install the Science and Technology | Don’t include this property if you

CONTENT category. included the FULL_GALLERY
category.

SPECIAL _ 1: Install the Special Needs category. | Don’t include this property if you

CONTENT included the FULL_GALLERY
category.

SPORTS_ 1: Install the Sports and Recreation Don't include this property if you

CONTENT category. included the FULL_GALLERY

category.

LAT_CONTENT

1: Install the Lesson Activity Toolkit
collection.

My Content folder, which is a location
on the user's computer where he or
she can store individual content.

TEAM_ [String]: Specify the path to the For information on creating a
CONTENT_ Team Content folder, which is a Team Content folder, see Creating or
PATH location on your school’s network connecting to Team Content folders
where users can store shared content. | on page 72.
You must specify a path to an existing
folder in this property.
MY_CONTENT | [String]: Specify the path to the You can include environment variables

in the path.

This property is useful if you want to
store content in a shared network
folder so users can access their

My Content folder from any computer
on the network.
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Property Allowed values Notes
PRINT _ 1 (default): Install the Print Capture The Print Capture Driver is a printer
CAPTURE Driver. driver that enables users to export
[Empty string]: Don't install the Print | content from other programs to
Capture Driver. SMART Notebook software by using
the SMART Notebook Document
Writer.
INSTALL_ 1 (default): Enable the registration of | Disable the registration of
DOCCAM _ SMART Document Camera drivers. SMART Document Camera drivers if
DRIVERS they conflict with existing third-party

[Empty string]: Disable the
registration of
SMART Document Camera drivers.

drivers on the computer.

GPU_ENABLED

1 (default): Enable hardware
acceleration.

0: Disable hardware acceleration.

Through hardware acceleration,
SMART Notebook software
completes some tasks using your
computer’s graphics processing unit
(GPU) rather than its central
processing unit (CPU). Hardware
acceleration improves the
performance of SMART Notebook
software on most computers.
However, hardware acceleration can
cause issues on some computers,
such as content not displaying
correctly and SMART Notebook
software not responding. If users are
encountering these issues, you can
disable hardware acceleration.

COPY_
TUTORIAL

1 (default): Copy the

SMART Notebook software tutorial
file to the user's Documents folder.
0: Don’t copy the SMART Notebook
software tutorial file to the user’s
Documents folder.

The SMART Notebook software
tutorial file opens when a user first
starts the software. It demonstrates
how to use the software and what’s
new in the current version of the
software.

If there is limited space on users’
computers, you can choose to not
copy the tutorial file to their
Documents folders.
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Property

Allowed values

Notes

SMART Response software properties

RESPONSE_
MODE

1: Install the software in standard
mode. (Students answer questions
using Senteo or SMART Response
clickers.)

2: Install the software in CE mode.
(Students answer questions using
SMART Notebook SE software.)

4: |nstall the software in LE mode.
(Students answer questions using
SMART Response LE clickers.)

8 (default): Install the software in PE
mode. (Students answer questions
using SMART Response PE
clickers.)

16: Install the software in XE mode.
(Students answer questions using
SMART Response XE clickers.)

32: Install the software in VE mode.
(Students answer questions using
SMART Response VE Internet-
enabled devices.)

64: Install the software in Mixed
mode. (Students answer questions
using Senteo, SMART Response,
SMART Response LE,

SMART Response PE or
SMART Response XE clickers or
SMART Notebook SE software.)
128: Install the software in Mixed
mode with additional support for
SMART Response VE Internet-
enabled devices.

You or the user can change the mode
after installation using the
SMART Response Setup Tool.

LOSU_RDM

1 (default): Add the

SMART Response icon to the
notification area when the user logs
on.

[Empty string]: Don’t add the
SMART Response icon to the
notification area when the user logs
on.
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Property Allowed values Notes
LOSU_RHWS 1 (default): Start the
SMART Response hardware service
when the user logs on.
[Empty string]: Don’t start the
SMART Response hardware service
when the user logs on.
INSTALL _ 1 (default): Install the
DATABASE SMART Response education
standards database.
[Empty string]: Don’t install the
SMART Response education
standards database.
FILE_PORT [String]: The port you want to use to This property is applicable only if
receive assessment information from | you're installing SMART Response
SMART Notebook SE software. software in CE mode.
SECURE_ [String]: The secure port youwantto | This property is applicable only if
BASE use to receive assessment you're installing SMART Response
PORT information from software in CE mode.
SMART Notebook SE software.
CERTIFICATE_ | [String]: The path to and file name of | This property is applicable only if
FOLDER the security certificate for Diffie- you're installing SMART Response
Hellman encryption. software in CE mode.
VE_SERVER_ [String]: The URL of the
WEBSITE SMART Response VE Server (for

example,
http://response.example.com).

SMART Product Drivers properties

ENABLE _ 1 (default): Use Tablet PC This property is applicable for the

STPCS functionality with the SMART Board Windows 7 operating systems. It has
interactive whiteboard without no effect on other operating systems.
connecting a Tablet PC. If you specify [Null], users don’t have
[Empty string]: Don’'t use Tablet PC touch support at the Windows logon
functionality with the SMART Board screen.
interactive whiteboard without
connecting a Tablet PC.

LOSU_ 1 (default): Start SMART Board Tools

BRDTOOLS when the user logs on.

[Empty string]: Don’t start
SMART Board Tools when the user
logs on.
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Property Allowed values Notes
LOSU_INK 1 (default): Start SMART Ink when the
user logs on.

[Empty string]: Don’t start SMART Ink
when the user logs on.

DEFAULT_PDF |1: Set SMART Ink Viewer as the
default PDF viewer.

[Empty string] (default): Don'’t set
SMART Ink Viewer as the default

PDF viewer.
LOSU _ [Empty string] (default): Don’t enable | Enable these services if your school or
VANTAGE the SMART Vantage and SNMP district is using SMART Vantage
services. software.

1: Enable the SMART Vantage and
SNMP services and, if you're
installing the software in Ul mode,
start the service after the installation

is complete.
INSTALL_ 1: Enable the registration of If you enable the registration of
UNSIGNED _ SMART Document Camera and unsigned third-party drivers, the
DRIVERS unsigned third-party drivers. installation process could ask users if
0 (default): Disable the registration of | they trust the makers of the drivers
SMART Document Camera and during installation. This can cause
unsigned thwd-party drivers. issues if you deploy the installation in

Silent mode. Therefore, it's best to
disable the registration of third-party
drivers if you deploy the installation in
Silent mode.

Language pack properties
Don’t select more than 20 language packs (see smarttech.com/kb/170081).

AR 1: Install the Arabic language pack.

ZH_CN 1: Install the Chinese (Simplified)
language pack.

ZH_TW 1: Install the Chinese (Traditional)
language pack.

CS 1: Install the Czech language pack.

DA 1: Install the Danish language pack.

NL 1: Install the Dutch language pack.
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Property Allowed values Notes

EN_GB 1: Install the English (UK) language
pack.

Fl 1: Install the Finnish language pack.

FR 1: Install the French language pack.

DE 1: Install the German language pack.

EL 1: Install the Greek language pack.

HE 1: Install the Hebrew language pack.

HU 1: Install the Hungarian language
pack.

IT 1: Install the Italian language pack.

MS 1: Install the Malay language pack.

NB 1: Install the Norwegian language
pack.

PL 1: Install the Polish language pack.

PT_BR 1: Install the Portuguese (Brazil)
language pack.

RO 1: Install the Romanian language
pack.

RU 1: Install the Russian language pack.

ES 1: Install the Spanish (Spain) language
pack.

SV 1: Install the Swedish language pack.

TR 1: Install the Turkish language pack.
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Property

Allowed values Notes

Internet access properties

ACC

[Integer]: Enable Internet access for
specified components.

¢ 0: No components

o 1: Gallery Setup

e 2:Language Setup

o 3: Gallery Setup and Language
Setup

o 13: All components except
Language Setup

o 14: All components except
Gallery Setup

o 15 (default): All components

The following are the standard Windows Installer parameters for the msiexec command.

Parameter Use
/q Hide the installation wizard.
NOTE
This is Silent mode.
/gb Show a basic installation wizard.
/gb! Show a basic installation wizard without a Cancel button.
/qb+ Show a basic installation wizard with a dialog box signaling the end of the
installation.
/gb+! Show a basic installation wizard without a Cancel button but with a dialog box
signaling the end of the installation.
lqr Show a reduced installation wizard.
qf Show the full installation wizard, including a dialog box signaling the end of the
installation or the Fatal Error, User Exit or Exit dialog box.
/gn Hide the installation wizard and the dialog box signaling the end of the
installation.
/gn+ Hide the installation wizard but show the dialog box signaling the end of the

installation.

54 smarttech.com/kb/170504




APPENDIX A

Windows Installer properties and parameters

The following example installs SMART Notebook software and SMART Product Drivers in Silent
mode:

msiexec /i " [Path]\SMARTEducationSoftware.msi" INSTALL NOTEBOOK=1
INSTALL BOARD=1 /g
The following example installs SMART Response software in Silent mode, providing a product key

and automatically activating the software upon completion of the installation:

msiexec /i " [Path]\SMARTEducationSoftware.msi" INSTALL RESPONSE=1
RESP_PROD KEY=[22- or 25-character product key] ACTIVATE LICENSE=1

/g

The following example installs SMART Notebook software in Silent mode, linking to centrally located
Gallery content:

msiexec /i " [Path]\SMARTEducationSoftware.msi" INSTALL NOTEBOOK=1
NETWORK_CONTENT=1 CONTENT_TARGET_PATH= "\\ SchoolServer\Gallery" /q

The following example installs SMART Response software in CE mode in Silent mode:

msiexec /i " [Path]J\SMARTEducationSoftware.msi" INSTALL RESPONSE=1
RESPONSE MODE=2 /g
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Installation language files and codes

Language Code File

English (U.S.) 1033 1033.mst
English (UK) 2057 2057.mst
Arabic 1025 1025.mst
Chinese (Simplified) 2052 2052.mst
Chinese (Traditional) 1028 1028.mst
Czech 1029 1029.mst
Danish 1030 1030.mst
Dutch 1043 1043.mst
Finnish 1035 1035.mst
French (France) 1036 1036.mst
German 1031 1031.mst
Greek 1032 1032.mst
Hebrew 1037 1037.mst
Hungarian 1038 1038.mst
Italian 1040 1040.mst
Norwegian 1044 1044.mst
Polish 1045 1045.mst
Portuguese (Brazil) 1046 1046.mst
Romanian 1048 1048.mst
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Language Code File
Russian 1049 1049.mst
Spanish (Spain) 1034 1034.mst
Swedish 1053 1053.mst
Turkish 1055 1055.mst
File Code

arabic_language_pack.msi

{C23C343B -ADAF 4716 -88A3 -7C83C834F77D}

chinese_(simplified)_language_
pack.msi

{138D3318 -7D69 402D -8F58 0622ECD91571}

chinese_(traditional)_language_
pack.msi

{CE1E8743 -3C65 40F7 B3DF -A4FC38224584}

czech_language_pack.msi

{9AF87867 96D2 4BA2 BB26 FOE6581C0C4A}

danish_language_pack.msi

{FCE289E7 FCED 4F74 9071 -EE03E176FC90}

dutch_language_pack.msi

{E4E2061B 2A6D 4F95 -A508 -DE546E60799B}

english_(united_kingdom)_language_

pack.msi

{2B2404AA -35DF 4BF3 -A8F2 BAFC8F7174C5}

finnish_language_pack.msi

{6EE5C940 -344A 40D3 92BA EBEAE1E27465}

french_language_pack.msi

{617193F6 4507 4A91 -AE67 BOFBAB5AA431}

german_language_pack.msi

{FE34C5E6 -CC3D 4C26 969A 0C2CAFB34658}

greek_language_pack.msi

{DBC33BCC -1AB1 4097 -81D8 +93184E7D2BE}

hebrew_language_pack.msi

{90203EF6 -AB6A 46F4 -8E80 DE6GOF753A0ES8}

hungarian_language_pack.msi

{7T3CF09CD E469 4EDC -A05C -73C2E34F0141}

italian_language_pack.msi

{269680E3 C467 4586 BB3C -34309FB52D51}

malaysian_language_pack.msi

{265909C5 F12F 4AD8 B6D8 -82F416F57BFA}

norwegian_language_pack.msi

{808F3C35 -A060 4A84 -818D -C19FE355E56D}

polish_language_pack.msi

{EED39364 -CBC2 4447 OD5A £€3915232D552}

portuguese_(brazil)_language_pack.msi

{0D535C96 -A6B6 4978 B173 E9050COEOE12}

romanian_language_pack.msi

{52B5DBD5 -185F 4662 B5BC 99BDFCOCFBC2}
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File

Code

russian_language_pack.msi

{FBODCEDC F5FF -46D6 8595 E8DB1262DFAF}

spanish_language_pack.msi

{89897CD3 1F77 -41F4 94D8 BA984F5D74A9}

swedish_language_pack.msi

{4F57BF84 3539 4FCF 9517 19CDBFA99606}

turkish_language_pack.msi

{TF7TEG8FA 2B88 47F3 -AC9F -81E36B145D4D}
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Gallery content includes the following:

o Gallery Essentials, which is a collection of educational photos and other images, audio files, and
Adobe Flash Player compatible files.

o Lesson Activity Toolkit, which contains objects teachers can use to create their own lesson
activities.

You can access Gallery content from the Gallery tab in SMART Notebook software.

There are three options for installing Gallery content.

Option Description

1 Install Gallery content on each user’s computer from the SMART website.

2 Install Gallery content on each user's computer from a folder on your school’s
network.

3 Install Gallery content in a central location, and then configure the software to refer

to that location.

EJ Tip

Option 3 is ideal for environments where hard disk space on computers is limited.

Installing Gallery content on each computer from the SMART website

Configuring Gallery content using the command line interface

If you're customizing the software using the command line interface, include the CONTENT _
TARGET_PATH property in the installation package customization. You can also include the FULL _
GALLERY and *_CONTENT properties to define the Gallery content you want to install. For more
information on these properties, see Windows Installer properties and parameters on page 43.

Configuring Gallery content using SMART Install Manager
If you're customizing the software using SMART Install Manager, complete the procedure in this
section to configure Gallery content.
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To configure Gallery content using SMART Install Manager

1.
2.

Open the software installation package in SMART Install Manager.
Click Product Selection.

The Product Selection page appears.

Select SMART Notebook (and any other products you want to install).
Click Gallery Content.

The Gallery Content page appears.

Click Install the Gallery on each computer.

In the Destination location box, type the path of the location on each computer where you want
toinstall the Gallery collections (if you don’t want to use the default folder).

Select the Gallery collections you want to install.

Publish your changes as an MST file, and then deploy the MSI and MST files.

Installing Gallery content on each computer from a folder on your
school’s network

Downloading Gallery content
Download Gallery content from the Intemet to a folder on your school’s network following the
procedures in this section, and then install the content on each computer from this folder.

To download Gallery content from the Internet

1.
2.

©® N o o
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Open the software installation package in SMART Install Manager.

Click Product Selection.

The Product Selection page appears.

Select SMART Notebook.

Click Gallery Content.

The Gallery Content page appears.

Click Install the Gallery on each computer.

Click Download, and then select the location to download the Gallery content to.
Click OK to start the download.

Click Close when the download is complete.
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Configuring Gallery content using the command line interface

If you're customizing the software using the command line interface, include the CONTENT _
SOURCE_PATH and CONTENT_TARGET_PATH properties in the installation package
customization. You can also include the FULL_GALLERY and * CONTENT properties to define the
Gallery content you want to install. For more information on these properties, see Windows Installer
properties and parameters on page 43.

Configuring Gallery content using SMART Install Manager
If you're customizing the software using SMART Install Manager, complete the procedure in this
section to configure Gallery content.

To configure Gallery content using SMART Install Manager

1.
2.

Open the software installation package in SMART Install Manager.
Click Product Selection.

The Product Selection page appears.

Select SMART Notebook (and any other products you want to install).
Click Gallery Content.

The Gallery Content page appears.

Click Install the Gallery on each computer.

In the Source location box, type the path to the folder on your school’s network that contains the
Gallery content (if you downloaded Gallery collections to your school’s network).

In the Destination location box, type the path of the location on each computer where you want
toinstall the Gallery collections (if you don’t want to use the default folder).

Clear the Gallery collections you don’'t want to install.

Publish your changes as an MST file, and then deploy the MSI and MST files.

Installing Gallery content in a central location

Downloading Gallery content
To place and use Gallery content in a central location on your school’s network, you must first
download the content from the Internet to that location by performing one of the procedures in this

section.

64

smarttech.com/kb/170504



APPENDIX C

Installing and maintaining Gallery content

To download Gallery content from the Internet

1.
2.

Open the software installation package in SMART Install Manager.

Click Product Selection.

The Product Selection page appears.

Select SMART Notebook.

Click Gallery Content.

The Gallery Content page appears.

Click Share Gallery content with all computers from a common network location.

If you want to download the Gallery Essentials collection, click Install beside
Essentials for Educators, and then follow the on-screen instructions.

If you want to download the Lesson Activity Toolkit collection, click Install beside
Lesson Activity Toolkit, and then follow the on-screen instructions.

Configuring Gallery content using the command line interface

If you're customizing the software using the command line interface, include the NETWORK _
CONTENT and CONTENT_TARGET_PATH properties in the installation package customization.
For more information on these properties, see Windows Installer properties and parameters on page

43.

Configuring Gallery content using SMART Install Manager
If you're installing the software using SMART Install Manager, complete the procedure in this section
to configure Gallery content.

To configure Gallery content using SMART Install Manager

1.
2.
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Open the software installation package in SMART Install Manager.

Click Product Selection.

The Product Selection page appears.

Select SMART Notebook (and any other products you want to install).

Click Gallery Content.

The Gallery Content page appears.

Click Share Gallery content with all computers from a common network location.

In the Gallery location box, type the path to the folder on your school’s network that contains the
Gallery content.

Publish your changes as an MST file, and then deploy the MSI and MST files.
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After installing the software, you can modify Gallery content using Gallery Setup. This program is
available under [Programs folderN\Common Files\SMART Technologies\SMART Product
Update and you can run it from a graphical user interface or the command line.

To run Gallery Setup from a graphical user interface

1.

66

In Windows Explorer, browse to [Programs folderA\Common
Files\SMART Technologies\SMART Product Update.

Double-click Gallery Setup.exe.

The Select a Gallery dialog box appears.

Select the Gallery collection you want to modify, and then click OK.
Gallery Setup starts.

In the Content tab, select the categories you want to include and clear the categories you don’t
want to include.

In the Languages tab, select the language packs you want to include and clear the language
packs you don’'t want to include.

£l nip

To see the language pack names in English, clear the Show native names check box.

In the Installation folder for Gallery content box, type the path to the folder where you want to
store the Gallery collection.

Click OK.
Gallery Setup updates the selected Gallery collection.

Click Finish.
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To run Gallery Setup from the command line
1. Open a Command Prompt window.

2. Type the following command:
"[Path]\Gallery Setup.exe" [Command] [Flags] [Parameters]

Where:
o [Path]is the path to the Gallery Setup.exe file.
NOTE

The default path is [Programs folderN\Common Files\SMART Technologies\SMART
Product Update.

o [Command]is acommand (see Commands below).
o [Flags]is one or more optional flags for the command (see Flags on the next page).

o [Parameters] is one or more parameters for the command (see Parameters on page 69).

NOTES
o Forexample commands, see Examples on page 70.

o Gallery Setup doesn’t support Windows Installer options.

3. Press ENTER.

Gallery Setup updates the selected Gallery collection.

Commands
The following table defines available commands for Gallery Setup.

Command Purpose Notes

--downloadall Download the entire Gallery collection to a

source folder.

--downloadsome

Download specific categories of the Gallery
collection to a source folder.

Specify which categories you want to
download using the --c parameter.

--installall

Install the entire Gallery collection from the
source folder to the destination folder.

If you omit the --source parameter, Gallery
Setup doesn’t use a default path unless you
provide the

--allowdownload flag.

If you omit the --destination parameter,
Gallery Setup uses the default path defined
in the Gallery collection’s configuration.
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Command Purpose Notes
--installsome Install specific categories of the Gallery If you omit the --source parameter, Gallery
collection from the source folder to the Setup doesn’t use a default path unless you
destination folder. provide the
--allowdownload flag.
If you omit the --destination parameter,
Gallery Setup uses the default path defined
in the Gallery collection’s configuration.
Specify which categories you want to
download using the --c parameter.
--teamcontent Register additional Team Content at the You must enter an existing Gallery
folder specified by the destination.
--destination parameter.
--mycontent Set the default My Content path to the folder
specified by the —--destination parameter.
--repair Attempt to detect and optionally remove Include the --allowcleanup parameter to
corrupted galleries. delete corrupted galleries.
--uninstall Remove the installed Gallery collection.
--register Define the location of Gallery content. Use this command with the

--destination and --configuration
parameters, or with the --guid parameter.

Flags

The following table defines available flags for Gallery Setup.

output when working in command line
mode.

Flag Purpose Notes
--remote Prevent Gallery Setup from registering itself | This disables the Check for Updates feature
with the SMART software. and prevents users from updating the
content.
--verbose Output progress of operations to standard

--overrideproxy

Set Gallery Setup to ignore default (system-
wide or previously set) proxy settings where
applicable, and use a proxy specified by the
--proxy parameter (server:port format),
using a user name and password provided
by the --username and --password
parameters.

You can set a user name and password
without --overrideproxy, and still use it for
authentication with the default proxy.

--allowdownload

Download the Gallery collection from the
default URL specified in the configuration.

Use this flag with the --installall or
--installsome parameters when you omit
the --source parameter.

--forcedest

Share Gallery content across users.
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Parameters
The following table defines available parameters for Gallery Setup.
Parameter Value Purpose Notes
--source [Path] Define the path to a local or network If you omit this parameter, the
folder where the Gallery content is installation program uses the default
stored before installation. URL from the Gallery configuration, as
specified by the --guid or
--configuration parameters.
--destination [Path] Define the path to a local or network If you omit this parameter, Gallery
folder where Gallery Setup installsthe | Setup uses this default path found in
Gallery content. the computer’s registry.
--configuration | [Path] Define the full path to a If you omit this parameter, you must
.gallerycollection file, including the file provide the --guid parameter to
name. specify a known Gallery collection.
--proxy [Server:Port] Specifies the proxy used by Gallery
Setup when you include the
--overrideproxy flag.
--guid [Identifier] Specify a known Gallery collection to A Gallery collection is known if Gallery
work with. Setup has already opened its
.gallerycollection file. In this situation,
use this parameter instead of the
--configuration parameter.
--C [Alias] Download or install the category of the | You caninclude several --c
Gallery collection identified by [Alias]. parameters in a single command. Valid
Use this parameter with the [Alias] values for the Gallery Essentials
—-downloadsome and collection are:
--installsome commands. e admin
e arts
e english
e geography
e history
e math
e people
e science
e special
e sports
—-ui N/A Specify the user interface level. Use --register with the
Use this parameter to show a --downloadall or
progress indicator and error --downloadsome parametersto
messages. If you don'tinclude this display the full user interface.
parameter, Gallery Setup works Use --register with the
silently without a user interface. --installall or --installsome
parameters to display a minimal user
interface.
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Examples

Downloading a Gallery collection
Use the following command to copy a Gallery collection from a specific source folder to a common
destination folder:

"[Path]\Gallery Setup.exe" --downloadall --destination " [Path]"

--configuration " [Path]"

Downloading certain categories of a Gallery collection
Use the following command to copy only certain categories of a Gallery collection from a specific
source folder to a common destination folder:

"[Path]\Gallery Setup.exe" --downloadsome --destination " [Path]"
--configuration " [Path]" --c "[Alias 1]" --c "[Alias 2]"

Installing a Gallery collection
Use the following command to install a Gallery collection from the default source (as defined in the
.gallerycollection file) to a specific destination folder:

"[Path]\Gallery Setup.exe" --installall --allowdownload --destination
"[Path]" --configuration " [Path]"

Installing certain categories of a Gallery collection
Use the following command to install certain categories of a Gallery collection from the default source
(as defined in the .gallerycollection file) to a specific destination folder:

"[Path]\Gallery Setup.exe" --installsome --remote —--source " [Path]"
--allowdownload --destination " [Path]" --configuration " [Path]"
--c "[Alias 1]" --c "[Alias 2]"

Registering installed Gallery collections
If you installed Gallery collections to a network location, use the following command to register the
Gallery content with the SMART software on each user’'s computer:

"[Path]\Gallery Setup.exe" --register --remote --forcedest

--destination " [Path]" --configuration " [Path]"
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Removing a Gallery collection
Use the following command to remove the Gallery Essentials collection:

"[Path]\Gallery Setup.exe" --uninstall --guid gallery.smarttech.com

E] Tip

To automate the removal of a Gallery collection, you can use the command in a batch file as a
startup script.

After installing the software, you can do the following:
e Change the location of the My Content folder.
o Create or connect to a Team Content folder.

e Connect to an RSS feed.

Starting the software in Administration mode
Before you can maintain content folders, you must start the software in Administration mode.

To start SMART Notebook software in Administration mode
1. Open a Command Prompt window.

2. Type the following command:
" [Path]\Notebook.exe" /admin
Where [Path] is the path to the SMART Notebook software program folder.

NOTE
The default path is [Programs folderNSMART Technologies\Education Software.

3. Press ENTER.

SMART Notebook software starts in Administration mode.

Changing the location of the My Content folder
The My Content folder is a location where teachers and students can store content for their individual
use.

You can specify the location of the My Content folder during installation or afterward.

71 smarttech.com/kb/170504



APPENDIX C

Installing and maintaining Gallery content

To change the location of the My Content folder after installation

1.

Start the software in Administration mode (see Starting the software in Administration mode on
the previous page).

Click the Gallery tab.

Click the Click here for more Gallery options icon #, and then select Administration:
Content Locations.

The Administration: Content Locations dialog box appears.

Click Browse.

The Browse For Folder dialog box appears.

Browse to and select the new My Content folder, and then click OK.
Click Close.

Close the software.

Creating or connecting to Team Content folders
All users can create new content and save it in their My Content folders. To allow users to share
content, you must create or connect to a Team Content folder.

EJ Tip

If you create a Team Content folder on a computer’s hard disk, the folder is available only to users
of that computer. However, if you create a Team Content folder on a server, the folder is available
to all users on the school’s network with read and write access to the folder.

To create a new Team Content folder

1.
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Start the software in Administration mode (see Starting the software in Administration mode on
the previous page).

Click the Gallery tab.

Click the Click here for more Gallery options icon #, and then select Administration:
Content Locations.

The Administration: Content Locations dialog box appears.
Click Create New.

The Browse For Folder dialog box appears.
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Browse to and select the folder you want to designate as a Team Content folder, and then click
OK.

NOTE

The software adds an imsmanifest.xml file to the Team Content folder after you click OK.
This file identifies the folder as a Team Content folder.

Click Close.

Close the software.

To connect to an existing Team Content folder

1.

Start the software in Administration mode (see Starting the software in Administration mode on
page 71).

Click the Gallery tab.

Click the Click here for more Gallery options icon #, and then select Administration:
Content Locations.

The Administration: Content Locations dialog box appears.

Click Add Existing.

The Browse For Folder dialog box appears.

Browse to and select the Team Content folder, and then click OK.
Click Close.

Close the software.

To disconnect a Team Content folder

1.
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Start the software in Administration mode (see Starting the software in Administration mode on
page 71).

Click the Gallery tab.

Click the Click here for more Gallery options icon ", and then select Administration:
Content Locations.

The Administration: Content Locations dialog box appears.
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4.

5.
6.

Select the folder in the Team Content list, and then click Remove.

IMPORTANT

If you installed the Gallery Essentials and Lesson Activity Toolkit collections, folders for those
collections appear in the Team Content list. Do not remove these folders from the list, or users
will not be able to access these collections.

Click Close.

Close the software.

Connecting to an RSS feed
You can connect to a public or private RSS feed to send information to your school’s
SMART Notebook software and SMART Notebook SE software users through the Gallery tab.

RSS is a format for delivering regularly changing web content. Many news-related websites, blogs
and other publishers broadcast their content as RSS feeds.

To connect to an RSS feed

1.
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Start the software in Administration mode (see Starting the software in Administration mode on
page 71).

Click the Gallery tab.

Click the Click here for more Gallery options icon ", and then select Administration:
Content Locations.

The Administration: Content Locations dialog box appears.
Type the URL of the RSS feed in the Online Resources box.
Click Close.

Close the software.
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Removing SMART Board software 8.X ... 76
Removing SMART Board software 7.X ... 78
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If you have version 9.0 or earlier of SMART Board software on your computers, SMART recommends
that you remove it before installing new software.

Removing SMART Board software 9.x

You or your predecessor installed SMART Board software 9.x using the Windows Installer 3.1
installation utility.

You can remove SMART Board software 9.x using the installation package (if you still have it) or the
product code.

. To remove SMART Board software 9.x

Run the following command to remove the software using the installation package:

msiexec /x " [Path]\SMART Board Software.msi" [Parameter]

Where
o [Path]is the path to the SMART Board Software.msi file.
o [Parameter] is the installation parameter (see Parameters on page 54).

OR
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Run the following command to remove the software using the product code:
msiexec /x [Product code] [Parameter]

Where

o [Product code] is the product code for the version of SMART Notebook software you're
removing, including the braces ({” and “}").

Version Product code

9.0.1.57 {D2EC1505-9F 11-4A94-9644-DCD0299DE491}
9.1.0.40 {BD6516BA-2314-4F2C-9ECD-29BCB1074AFB}
9.1.3.47 {8D757887-9CD3-4F97-9873-E049E1C264CE}
9.1.4.51 {EE2A5345-CBE2-4932-83B0-D628D0D24AF 8}
9.5.x.x {B72EB184-2A42-4B3C-8F8F-D7EF163829B4}
9.7.x.x {46486451-E60F-42C3-92D7-796D8594688A}

o [Parameter] is the installation parameter (see Parameters on page 54).

You or your predecessor installed SMART Board software 8.x using the InstallShield® installation
utility.

You can remove SMART Board software 8.x by creating a setup.iss file and then using the file to
remove the software from all computers.

NOTE

You need to create the setup.iss file only once. You can then use the file to remove the same
version of SMART Board software from other computers on your network using a batch file or
startup script.

Before completing the following procedures, determine the product code for the version of
SMART Board software installed on the computers.

Version Product code
8.0.0.52 {7823065C-AA6G4-425D-A9A3-18BF7B99E 944}
8.0.1 {F414173A-7BE1-46C6-811A-51277A4D9E7B}
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Version Product code

8.1.0 {155FBC4E-CF09-4698-961B-DF9787E6B3B8}
8.1.1.24 {TAD771BB-B681-4659-B7FA-223FCB1FDF56}
8.1.2.8 {65C574CA-8D71-46F1-9897-98D AE55C 0394}
8.1.3.17 {10D2A154-D221-4455-8426-E67D 12C092F 9}
8.1.4.19 {41CEFD25-0D33-44EA-A19C-5A1EBABFC041}

The product code includes the braces (“{” and “}’).

To create the setup.iss file

1. Run the following command:

"C:\Program Files\Common Files\InstallShield\Driver\8\Intel 32\
IDriver.exe" /MProductCode /11033 /r/z-AddRemove --RemoveReg

The InstallShield installation utility removes SMART Board software and creates a setup.iss file
in the root Windows folder.

2. Move the setup.iss file to a location where all computers can access it.

To remove SMART Board software 8.x

Run the following command:

"C:\Program Files\Common Files\InstallShield\Driver\8\Intel 32\
IDriver.exe" /MProductCode /11033 /s /z-AddRemove -RemoveReg /fl1"
[Path to the setup.iss file]\setup.iss"/f2" [Path to the

uninst.log file]\uninst.log"

Where

o [Path to the setup.iss file] is the path to the setup.iss file you created in the previous
procedure.

o [Path to the uninst.log file] is the path to the log file that the InstallShield installation utility
creates when it removes the software.
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You or your predecessor installed SMART Board software 7.x using the InstallShield installation
utility.

You can remove SMART Board software 7.x by creating a setup.iss file and then using the file to
remove the software from all computers.

NOTE

You need to create the setup.iss file only once. You can then use the file to remove the same
version of SMART Board software from other computers on your network using a batch file or
startup script.

Before completing the following procedures, determine the product code for the version of
SMART Board software installed on the computers.

Version GUID

7.0 {72226969-B20E-439E-BOA1-FD1EE5403CCF}
7.1 {93458E57-1D 12-4F01-980D-62D5430048D 0}
7.1.1 {14AE43DA-37FE-4B73-99C0-D02E01B48837}
7.1.2 {28E27E54-92A5-4717-A4E5-837D7E894AB4}
7.1.3 {FF332803-8B46-4392-A2F4-8790735F7B26}

The product code includes the braces (“{” and “}’).

To create the setup.iss file

1. Run the following command:

RunD1132
C:\PROGRA~1\COMMON~1\INSTAL~1\PROFES~1\RunTime\0701\Intel32\
Ctor.dll,LaunchSetup "C:\Program Files\InstallShield Installation
Information\GUID\setup.exe" /r -10x9 --AddRemove

The InstallShield installation utility removes SMART Board software and creates a setup.iss file
in the root Windows folder.

2. Move the setup.iss file to a location where all computers can access it.
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To remove SMART Board software 7.x

Run the following command:

RunD1132
C:\PROGRA~I\COMMON~I\INSTAL~I\PROFES~I\RunTime\0701\Intel32\
Ctor.dll,LaunchSetup "C:\Program Files\InstallShield Installation
Information\GUID\setup.exe" /s -10x9 --AddRemove /fl" [Path to the

setup.iss file]\setup.iss" /f2" [Path to the setup.log file]
\setup.log"

Where

o [Path to the setup.iss file] is the path to the setup.iss file you created in the previous
procedure.

o [Path to the setup.log file] is the path to the log file that the InstallShield installation utility
creates when it removes the software.

When you remove a previous version of SMART Notebook software, the removal process can leave
behind registry entries, preventing you from installing the latest version of the software.

'S cAuTION

Use caution when you open the Windows registry editor. If you incorrectly modify the Windows
registry, you can damage your computer’s operating system. Back up your registry before
performing the following procedures.

If you're still having difficulties with remaining registry files, ensure that you have administrator rights
and manually search the registry for SMART Notebook software, SMART Board software or
SMART Product Drivers files.

'Y cAuTION

Do not remove files for other SMART products you want to retain. If you are unsure, contact
SMART Support (smarttech.com/contactsupport).
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To manually clean the registry
1. Press START+R.
The Run dialog box appears.
2. Typeregedit, and click OK.
The Registry Editor window appears.
3. Locate SMART files in the following locations, and then delete them:
o HKEY_CURRENT_USER\Software\SMART Technologies Inc.
o HKEY_LOCAL_MACHINE\Software\SMART Technologies Inc.
o HKEY_CURRENT_USER\Software\SMART Technologies
o HKEY_LOCAL_MACHINE\Software\SMART Technologies
4. Close the Registry Editor window.

5. Restart your computer.
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